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1. Introduction 

Welcome to the Slit ‘N Sew™ Quilt Designer!  We hope that you find using it straightforward, helpful and 

fun! 

Slit ‘N Sew Quilt Designer (henceforth called Quilt Designer for short) allows you to easily create block-

oriented quilt designs (e.g., Drunkard’s Path).  With just clicks of the mouse, you add blocks to your 

design to which you can rotate them, fill them with colors or fabric swatch images, and copy them.  At 

the click of a button, it will generate a summary telling you how many pieces of which block type there 

are for a specific color or fabric and how much yardage you’ll need. 

To extend your creativity – and have even more fun - you can mix/match block types of the same size in 

the same quilt design! 

Please note that Quilt Designer is intended to support products and services offered by Quilter’s 

Paradise.  This initial version of Quilt Designer allows creating designs using Slit ‘N Sew™ templates.  

Over time, additional capabilities may be added. 

The rest of this User Manual tells you how to use Quilt Designer. 

2. Getting Started 

To use Quilt Designer, you simply need to download an HTML file (i.e., a web page) to your PC that you 

view with a browser.  Quilt Designer is supported only by the Chrome and Firefox browsers on a 

Windows 7,8 or 10 PC.  If you already have Chrome or Firefox installed, please be sure it’s updated as 

older versions won’t support the needed functionality. 

To download Quilt Designer, go to http://www.quiltersparadiseesc.com/Quilt Designer/Quilt Designer 

Download.php and follow the directions on the page. 

There is no license required to use Quilt Designer.  You may use it free for non-commercial, personal 

purposes on as many computers as you wish. 

To update your browser’s software: 

Chrome 

Click on the Control icon in the upper right hand corner to display the control menu and 

select and click on “Update Google Chrome”. 

Firefox 

Click on the menu icon in the upper right hand corner to display the menu and click on 

Help, then About Firefox.  Firefox will automatically check for updates and download 

them if there are.  Once downloaded, click on Restart to update Firefox. 

If you don’t have Chrome or Firefox installed, to install: 
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Chrome 

Go to https://www.google.com/chrome/ and follow the instructions. 

Firefox 

Go to https://www.mozilla.org/en-US/firefox/new/ and follow the instructions. 

 

3. Background 

Quilt Designer is a web application:  it consists of software that a web browser understands and uses to 

render a page and support interactions with a user.  The web page is downloaded to your computer and 

makes use of software that exists “in the cloud” (specifically, on our web site). 

We elected to use a browser-based approach because virtually everyone who uses a computer knows 

how to use a browser and today’s modern browsers support sophisticated graphical capabilities that are 

fundamental for tools, such as Quilt Designer. 

As with any choice, there are both pros and cons.  There are several browsers in the marketplace and 

browsers don’t always perform exactly the same way in a particular situation.  This can (and does) lead 

to compatibility problems and challenges.  At this point in time, we have limited support of Quilt 

Designer to Chrome and Firefox for the following reasons: 

1. These two browsers account for approximately 80% of browser usage on Windows-based PCs. 

2. These browsers are faithful to published and agreed upon web standards. 

3. They are highly compatible with each other. 

Safari is no longer supported on Windows and, unfortunately, Internet Explorer diverges from the 

standards in a few critically important areas. 

Quilt Designer is supported on Windows 7 and later platforms.  While we don’t prevent you from trying 

to use it on another platform, we cannot vouch for whether it will work and we will not support such 

use.  It is possible that support may be extended to other browsers and platforms in the future, but we 

make no promises at this time. 

As a final background comment, we intended Quilt Designer as a simple and enjoyable, yet very capable, 

tool to help people create designs using their Slit N Sew templates.  There are undoubtedly many 

features that can be envisioned to add to Quilt Designer – and we welcome any and all feedback.  

However, we do not envision Quilt Designer evolving to be a “full fledged” quilt design tool akin to 

Electric Quilt. 

4. Page Layout 

The Quilt Designer page consists of three main sections as depicted in Figure 4.1 below: 
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Workspace – this is in the middle of the page and is where you design your quilt.  It consists of 

square blocks arranged in rows and columns (what Electric Quilt calls s “Horizontal Layout”).  At 

this time, Quilt Designer only supports those Slit ‘N Sew templates that form square blocks all of 

the same size.  Initially, the workspace is empty. 

Tools and Actions – this is located on the left hand side of the page and is where you select 

actions to perform on the workspace to create your design. 

Swatch Images – this is located on the right hand side of the page and is where you may add and 

select swatch image files that you can use to fill the block shapes. 

Additionally, Quilt Designer can calculate how much fabric you need to make the design you created.  

These calculations are displayed in a separate window.  Please refer to Section 7. 

 

Figure 4.1:  Page Layout 

5. Workspace 

Creating the Workspace 

The first step in making a design is to create the workspace.  To do so, simply click the Add button under 

“Add / Delete Rows and Columns”.  By selecting where to add rows and columns in the drop-down 

menu (Top, Right, Bottom, Left), you can create a workspace consisting of the number of rows and 

columns that you want.  You may add and delete rows and columns at any time as you work on your 
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design.  The workspace will appear consisting of light gray colored squares each of which is a block in the 

quilt design.  Once created, you may then create your quilt design using the Block Action commands. 

Zoom 

Depending on how many rows and columns you have in your workspace, the workspace may have 

scrollbars to access all of the individual blocks.  You may use the Zoom In and Zoom Out buttons to 

enlarge or reduce, respectively, the size of the displayed blocks.  Hence, zooming out is useful in 

situations where you have a larger project and want to see the entire workspace.  Conversely, zooming 

in may be easier for filling individual shapes when the shapes, themselves, are smaller. 

Tooltips 

To the right of the Zoom In / Zoom Out buttons is a Tooltip button.  Initially it is grayed out meaning that 

tooltips are disabled.  Click on the Tooltip button to enable tooltips (the Tooltip button will no longer be 

grayed out).  Placing your mouse over various elements will provide additional information to you: 

Tools and Icons – the purpose and function of the tool/icon are displayed. 

 

Figure 4.2 

Workspace – placing your mouse over a shape within a block will display the name and piece 

designation of the shape along with what it is filled with (which color or swatch).  It also displays 
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the block number
1
.  If the block in the workspace is empty (i.e., it is not populated with a block 

type shape), then no tooltip is displayed for that block. 

 

Figure 4.3 

Swatch – placing your mouse over a swatch image in the swatch space will display the full path 

name to where the image for swatch exists. 

                                                           
1
 Blocks are numbered starting with the top left-most block being block number one and proceeding left-

to-right and then to the next row.  For example, suppose there are 4 rows and 5 columns of blocks.  The 

first block in the second row is block number 6 and the last block (row 4, column 5) is block number 20.  

If tooltips are enabled, when you place the mouse over a block, its block number will be displayed. 
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Figure 4.4 

To disable tooltips, simply click on the Tooltip icon and the icon will be grayed out. 

Block Actions 

Block actions are divided into 2 groups as identified by the background color in the drop-down 

menu.  The first group provides basic functionality, specifically, adding, copying, removing and 

rotating blocks. 

Add 

This action adds a block to the workspace.  Select Add from the Block Actions drop-

down menu and select the desired Block Type from its drop-down menu
2
.  Then click on 

the block in the workspace that you want to add the block to.  If a block has already 

been added, it will be overwritten.  By default, the shapes within the block will be filled 

with the color white. 

This version of Quilt Designer supports the following Slit ‘N Sew templates: 

Double Wedding Ring 

Drunkard’s Path 

Melon 

                                                           
2
 The Block Types drop-down menu is enabled for use only when the Add block action is selected. 
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Winding Ways 

Also, to provide additional versatility, the following basic block types are also supported 

for creating your designs.  They appear in the drop-down menu after the Slit ‘N Sew 

templates and have a different background color in the menu.  You will need to cut 

these shapes yourself. 

Drunkard’s Path Companion 

Four Patch 

Half Square Triangle 

Nine Patch 

Square 

Over time, we expect to add additional blocks and shapes. 

Copy 

This action allows you to copy one block to another block within the workspace.  Select 

Copy from the Block Action drop-down menu.  Then click on the block in the workspace 

that you want to copy.  Then click on the block you want to copy to.  You may continue 

to click on other blocks to continue the copying process.  To recap, the first click selects 

the copy-from block and the second, third, etc. clicks select the copy-to block and cause 

the copy to occur. 

If you hold the control key while performing the second (or beyond) click, the copy-from 

block will be copied to ALL blocks in the workspace.  If you hold the alt key while 

performing the second (or beyond) click, the copy from block will be copied to all odd 

numbered blocks if the copy-from block number is odd or to all even numbered blocks if 

the copy-from block number is even. 

Remove 

This action removes the shape that is populated in a block.  Select Remove from the 

Block Action drop-down menu and then click on the block that you want to remove.  If 

you hold the control key while clicking on any block in the workspace, ALL populated 

shapes in the workspace will be removed. 

Rotate 

This action allows you to rotate a block.  Select Rotate from the Block Action drop-down 

menu and then click on the block that you want to rotate.  Each click on the block will 

rotate it 90 degrees in the clockwise direction. 
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The second group of block actions handles the fill of the shapes of the blocks. 

Fill with Color 

This action allows you to fill a shape within a block with a color.  Select Fill with Color 

from the Block Action drop-down menu and then select the desired color from the Fill 

Colors drop-down menu
3
.  Then click on the shape that you want to fill. 

Fill with Image 

This action allows you to fill a shape within a block with a swatch image.  Select Fill with 

Image from the Block Action drop-down menu and then select the desired swatch image 

by clicking on it.  The selected swatch image is displayed with a blue border around it.  

Then click on the shape that you want to fill. 

Clear All Fill 

This action sets the fill to ALL shapes in ALL blocks in the workspace to the default color 

of white.  This command is very useful if you open an existing Quilt Designer file and 

don’t want to use the fill colors or swatches that were used.  Once you open the file, use 

the Clear All Fill action to reset the fill to white after which you can fill the shapes with 

whatever you wish.  Alternatively, if you wish to change the fill for a portion of the 

shapes, then use the Fill with Color and Fill with Image actions to change the fill on a 

shape-by-shape basis. 

To help you know which action has been selected and is active at the moment, each action has a unique 

mouse cursor displayed when the mouse cursor is positioned anywhere over the work space.  The 

following table shows the cursor for each action. 

 

Action Mouse Cursor 

Add 
 

Copy (select copy from) 
 

Copy (perform copy to) + 

Remove 

 
Rotate 

 
Fill with Color 

 
Fill with Image 

 
Clear All Fill Not applicable 

                                                           
3
 The Fill Colors drop down menu is enabled for use only when the Fill with Colors action is selected. 
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Please note that there is no undo action to reverse the effects of the previously executed 

action.  Instead, you will need to execute the necessary actions to restore your design to 

the desired state. 

6. Swatch Images 

Quilt Designer allows you to fill shapes within the blocks with swatch images from fabric manufacturers 

(or, for that matter, from any source).  Swatch images must be of one of these file types:  .jpg, .gif or 

.png.  Additionally, the swatch image files that you use may be located on the web or on your computer. 

Adding a Swatch 

To add a swatch, open a new tab in your browser and navigate to where the swatch 

image is that you want.  Right-click on the swatch image and select “Copy Image 

Address” (Chrome) or “Copy Image Location” (Firefox).  Select the tab that has Quilt 

Designer open and click in the text box that says “Swatch File Location”.  Then paste the 

swatch file location into the text box by either selecting Paste from the browser’s menu, 

right clicking in the text box and selecting “Paste”, or using the ctrl-V keyboard shortcut.  

Then click the Add button.  The swatch will then appear in the Swatch Images space. 

Selecting a Swatch 

To select a swatch, simply click on it.  A blue border will appear around the image. 

Removing a Swatch 

Click on the image of the swatch you want to remove and then click the Remove button.  

If a swatch is being used as a fill in one or more shapes in the workspace, you will be 

alerted that you may not remove the swatch image.  If you want to locate the pieces 

that are using that swatch as fill and it is not obvious by looking at the workspace, click 

on the tooltips icon to enable tooltips and place your mouse over the pieces one at a 

time.  As you do so, the path name of the swatch image will be displayed. 

 

7. Fabric Needs 

Once you create your quilt design, you can calculate how much fabric you will need.  To do so, click on 

the “Yardage” button.  You will be prompted for the finished size of the block.  Once entered, a new 

window in your browser will be opened.  In that window, at the top, the dimensions of the quilt are 
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displayed
4
.  Below that, the first displayed table will show the following for each piece of each block in 

the quilt: 

The block type and piece within that block. 

The color or fabric swatch for that piece. 

The number of pieces used within the quilt design. 

The width of a strip of fabric to be cut and the number of such strips to be cut. 

The yardage of fabric needed for that piece given the number of strips to be cut and the width 

of the strips rounded up to the nearest eighth yard. 

A second table is then displayed giving the overall total yardage per color and per swatch image.  

(Different block types and pieces may use the same fabric and so their yardage is combined.) 

Finally, displayed is a list of notes and clarifications to aid in understanding the fabric needs calculations. 

Click the Print button at the bottom of the page to print the fabric needs calculations. 

Additionally, Quilt Designer is connected to our border and binding calculators should you wish to 

calculate yardage for either or both of those. 

8. Saving and Opening Designs 

8.1 Saving Your Design 

To save your design, click on the :Save button.  A new window will open that will include instructions for 

completing the save operation.  A recap of these instructions follows: 

Chrome 

Click on the control icon in the upper right hand corner, scroll down to More Tools and 

select Save Page As. 

Alternatively, right-click on the web page and select Save As. 

Firefox 

File > Save Page As 

Alternatively, right-click on the web page and select Save Page As. 

Regardless of which browser you use, you will be saving a web page (i.e., an htm or html file).  You may 

wish to create a folder on your PC for storing all your designs in one place. 

                                                           
4
 Please note that if your design has a row or column consisting of all empty blocks along the edge of the 

design, those empty blocks will be included in the calculations of the quilt’s dimensions. 
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You may save whenever and as often as you like.  Please note that if you exit the web 

page containing your design, you will not be warned if there are unsaved changes and 

thus you will lose them. 

Please do not modify or edit a saved Quilt Designer file except by using Quilt Designer.  

If you do, Quilt Designer may not work as designed and intended. 

8.2 Opening A Previously Saved Design 

You may open a previously saved design by clicking the Open button.  This will cause a new window to 

open where you may navigate to where the file is stored on your computer.  Select the file you wish to 

open and click the Open button. 

If you open a Quilt Designer file in the same browser window that you are already working on a design, 

be sure to first save your work since opening the file will replace everything.  To work on multiple files 

and designs at the same time – see Section 8.4. 

When opening a file, Quilt Designer will check to see if the file being opened was created by a newer 

version of Quilt Designer.  In such cases, Quilt Designer may not open the file and alert you that you 

should upgrade your version. 

8.3 Sharing Your Design 

You can share your design in one of two ways: 

Saved Quilt Designer file (see Section 8.1 above) 

Create a jpg file of your design (see Snipping tool below) 

Snipping tool 

To access the tool 

Click on the Windows Start button. 

Type “snipping tool” in the search bar. 

Select the snipping tool by clicking on it. 

A new window for the Snipping Tool will appear along with a crosshair mouse cursor.  Position 

the crosshair mouse cursor at the upper left hand corner of your design in the workspace and 

click and drag the mouse to the lower right hand corner.  Release the mouse click.  In the 

Snipping Tool window, select File > Save As and save the image you selected. 

8.4 Working Multiple Designs and Files 

You can open and work on multiple designs at the same time!  Just open a new browser tab for each 

design. 
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9. Help 

In the Tools & Actions section toward the bottom is a help drop-down menu.  The following options may 

be selected: 

User Guide 

This opens the Quilt Designer User Manual. 

Video Tutorials 

This opens the Quilt Designer Video Tutorials web page from which you can select the 

tutorial you wish to view. 

Check Updates 

This determines whether your version of Quilt Designer is the latest available version.  If 

not, you have the option of downloading the latest version. 

Feedback 

This opens a new window and takes you to a web page where you may report a 

problem, ask a question, make a suggestion, or provide feedback.  Please note that we 

read all communications and appreciate any and all feedback, but are unable to respond 

to each and every one. 

Terms of Use 

This opens a new window containing Quilt Designer’s terms of use which we encourage 

you to read.  In plain English, we’ve done our best to create a tool that we believe and 

hope will help you in creating project designs that use our Slit ‘N Sew templates.  And, 

we hope that you will have fun using the tool doing so … we sure have!  Please 

recognize, though, that we have offered the tool for free for non-commercial, personal 

purposes and it is offered “as is”, with no warranty.  And, by using the tool, we assume 

that you agree to the Terms of Use. 

About 

Displays the version of Quilt Designer. 

10. Social Media 

We invite you to share your comments, feedback and designs on social media!  Below the Help menu is 

the Social Media menu where you can go to our Facebook page or Instagram page. 

 


